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Landscape Ecology and Analysis 
RNG 450/550 

 
Lab # 2: Introduction to ArcGIS 8.x 

 
 
 
 
Purpose: 
 
The first laps cover fundamental GIS concepts as well as how to query a GIS database, 

manipulate tabular data, edit spatial and attribute data, and present data clearly and 

efficiently using maps and charts. You will learn how to use ArcMap™, ArcCatalog™, 

and ArcToolbox™ and explore how these applications work together to provide a 

complete GIS software solution.  This software was developed by Environmental 

Systems Research Institute (ESRI), California. 

 
 
Specific learning objectives: 

Find out what a GIS is used for and the basic concepts you need to know to work with 
one. 

Learn the structure of ArcGIS and how its different parts provide integrated and 

powerful tools for solving real-world problems. 

Learn about the basic functionality of ArcCatalog™, ArcMap, and ArcToolbox™ 

In this lab, you will learn:  

• The three ArcGIS applications that comprise ArcView 8 and about some of their 
primary functions. 

• How these new ArcGIS applications work together to make it easier for you to 
learn and use the software. 

• Ways you can customize how you work with ArcView 8 

 
Data set: 
Esri exercise 
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Introduction 

ArcView 8 is a powerful GIS data visualization, query, analysis, and map creation 

solution designed for Microsoft® Windows.  

ArcView includes ArcCatalog, ArcMap, and ArcToolbox: 

• ArcCatalog— the tool for exploring and managing your data. It is used to browse 
and manage geographic data sources and create and update metadata  

• ArcMap— the application for feature display and editing, mapmaking, and 
analysis  

• ArcToolbox— the environment for performing operations such as data 
conversion and geoprocessing tasks. It contains powerful tools for performing 
geographic analysis and data conversion  

             ArcMAp 

 

 
ArcCatalog ArcToolbox 

 

ArcGIS works with extension products, including:  

• Spatial Analyst  
• ArcView 3D Analyst™  
• Geostatistical Analyst  

 

With ArcView 8 you can:  

• explore, display, and query spatial data  
• access a comprehensive suite of editing tools for shapefiles and perform simple 

feature editing on personal geodatabases  
• perform geoprocessing operations  
• create presentation-quality maps with a comprehensive suite of cartographic 

tools and wizards  
• create reports and sophisticated two- and three-dimensional graphs  
• perform layer-level projection (including imagery)  
• create and manage annotation  
• view maps from the Internet  
• import data from and export data to a variety of common formats  
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ArcCatalog    

ArcCatalog is the ArcView 8 application you use to find, explore, and manage your data. 

With ArcCatalog, you can browse and preview data stored on your local computer, 

network, or even on the Internet. You can directly access maps and data. You can 

launch ArcMap and ArcToolbox from within ArcCatalog to begin working with your data 

any time. 

Step 1: Start ArcCatalog and open a geodatabase 

If you have a shortcut icon for ArcCatalog on your desktop, double-click it to start 

ArcCatalog. Another way to start the application is to click the Start menu, then click 

Programs, ArcGIS, ArcCatalog.  

The Catalog Tree 

The first time you open ArcCatalog, you will see your computer's hard disks plus 

Database Connections, Geocoding Services, and Internet Servers entries on the left 

side of the application window. To access data stored on a CD–ROM, floppy disk, or 

another computer on the network, you must connect to them. The collection of 

connections you set up to geographic data is called the Catalog. After you connect to a 

folder or database, your connection appears in the Catalog Tree.  

You use the Catalog Tree, which is similar to Microsoft's Windows Explorer, to browse 

your data. Once you've found the data you want to work with, you can preview it in 

ArcCatalog. You can also drag the dataset from the Catalog Tree and drop it directly 

into ArcMap for enhanced display, mapping, and analysis. You can even drag and drop 

files from ArcCatalog into ArcToolbox wizards and tools. 

When ArcCatalog opens, look in the Catalog Tree on the left side of the window. You 

should see a connection to the folder that contains the data for this lab (Lab_2).  

If you don't see this connection, click the Connect to Folder button . Navigate to the 

RNG450 folder on your computer where the data for this lab has been saved 

(C:\RNG450\LAB_2\Section_a). Click OK. 
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In the Catalog Tree, expand the folder connection you just set up by clicking its plus 

sign (+). Double-click National to open it. 

National.mdb is a personal geodatabase, a new type of data model introduced with 
ArcGIS.  

Expand both the USAContainer and the WorldContainer. 

 

 

Step 2: Preview features from the geodatabase 

In ArcCatalog, you can preview both geography and attributes for spatial data. In the 

Preview tab, you display geographic features using Geography view. 

On the right side of the ArcCatalog window, click the Preview tab to make it active. In 

the Catalog Tree, double-click WorldContainer. Click Countries94 to make it active.  
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Now click WorldCities to preview the world cities. 

 

 

Step 3: Preview a feature class table 

In the Preview dropdown list below the preview area, choose Table. Now you see the 

World Cities attribute table. Examine its fields.  

 
 
 

Table Preview mode allows you to investigate and compare attributes. 
You can sort fields, add fields, and export the table. 

 
ArcCatalog also includes familiar tools to zoom, pan, and identify features. 
 

 
 

Use the Geography toolbar to zoom and pan or identify features in your data. 
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Step 4: Create metadata 
 
Metadata: Descriptive information about a collection of data. Metadata for geographic 

data may include the source of the data; its creation date and format; its projection, 

scale, resolution, and accuracy; and its reliability with regard to some standard. 

Metadata consists of properties and documentation. Properties are derived from the 

data source (e.g., the coordinate system and projection of the data), while 

documentation is entered by a person (e.g., key words used to describe the data set). 

 

An important feature in ArcView 8 is the ability to create and store metadata GIS files or 

database. ArcCatalog provides the tools to create, view, manage, and export metadata. 

Clicking the Metadata tab shows you descriptive information about the data you are 

exploring. Metadata includes properties and documentation. ArcCatalog derives and 

records properties from the data source, while the user generates documentation. 

 

 
 
Inside the Metadata tab, there are three additional tabs to help you organize metadata. 

In Description, you can document your data in detail. In the Spatial tab, ArcCatalog 

automatically records the bounding coordinates and spatial data information. The 

Attributes tab, shown above, shows table and field definition parameters. 
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ArcMap  
 

ArcMap is the ArcView 8 application that you use to visualize, create, edit, query, 

analyze, and present your data. In many ways, the ArcMap software interface is most 

like the ArcView 3.x interface you are familiar with. There is a map display area for 

viewing spatial data and a Table of Contents (TOC) in which dataset names and 

symbology are listed. 

 
Step 1: Start ArcMap. 

Click the Launch ArcMap button . You can also start ArcMap by clicking the Start 

menu, then choosing Programs, ArcGIS, then ArcMap.  

If an ArcMap dialog appears, click "A new empty map" and click OK.  

 

Arrange and resize the ArcMap and ArcCatalog application windows so that you can 

see both application windows and their contents at the same time on your screen. 
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Step 2: Drag and drop data into ArcMap 

In ArcCatalog, click the Contents tab, then in the Catalog Tree, click WorldContainer. 

Click Countries94 and drag it into the ArcMap map display area. 

 

The world countries are displayed in ArcMap. 

Minimize ArcCatalog. 

You can also click the Add Data button . In the Add Data dialog, click the Connect to 

Folder button and navigate to the RNG folderfor this lab 

(C:\RNG450\LAB_2\Section_a) double-click National.mdb, then double-click the 

WorldContainer dataset. Finally, click WorldCities and click Add 

Lab 2 - 8 



Laboratory Manual for Landscape Ecology    Harris, Louhaichi & Johnson 

 
. 

 
Step 3: Dock the tools toolbar 

If the Tools toolbar is floating separately on your desktop, drag it into the middle of the 

ArcMap window so that it is docked between the Table of Contents and the map display 

area as shown in the View Result graphic below. 

               
 

Click the title bar of the Tools toolbar and drag it over the ArcMap interface. (If your 

Tools toolbar was already docked, click the gray bar at the top of the toolbar and drag.)  
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A gray box representing the position of the Tools toolbar appears when you move the 

mouse over the interface.  

 

Keep holding the mouse button down and move the toolbar over the top and edges of 

the ArcMap window.  

The gray box changes shape, indicating different docking locations in the interface.  

Move the toolbar's outline so it is over the bar that separates the Table of Contents from 

the map display area. The gray box turns into a tall thin rectangle. Release the mouse 

button. 

The Tools toolbar is now docked between the Table of Contents and the map display 

area. Your ArcMap interface should look like the one in the View Result graphic below.  
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Step 4: Hide the Draw toolbar 

The Draw toolbar appears at the bottom of the ArcMap window. Because you won't be 

needing it in this lab, you will hide it. (If your Draw toolbar is not visible, from the View 

menu, choose Toolbars and click Draw to display that toolbar.) 

From the View menu, choose Toolbars, then click Draw.  

The Draw toolbar is removed from the ArcMap interface. 

 
 

The Toolbars command in the View menu has a list of all the toolbars. The ones 

currently displayed are checked.  

Step 5: Close and reopen the Table of Contents 

You can also remove the Table of Contents from the interface. 

In the upper-right corner of the Table of Contents, click the X.  

The Table of Contents disappears from the interface. 
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To display the Table of Contents again, from the View menu, choose Table of Contents. 

The Table of Contents is restored to the interface. 

Step 6: Undock the Table of Contents 

You can undock the Table of Contents to make it its own floating window. 

Click on the double bar above the Table of Contents and drag it away from the ArcMap 

window.  The Table of Contents undocks and floats off to the side. 
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Step 7: Dock the Table of Contents 

The Table of Contents is similar to other toolbars. You can dock it many places on the 
ArcMap interface. 

Click the title bar of the Table of Contents window and drag it over the top part of the 

ArcMap display area until it turns into a horizontal rectangular shape. Release the 

mouse button.  

The Table of Contents is now docked above the display. 

 
 

Step 8: Hide scroll bars and the status bar 

If you want to create more room for the map display area, another thing you can do is 
hide the scroll bars and the status bar.  

To hide the scroll bars, from the View menu, click Scrollbars. 

The display window scroll bars disappear. 

To hide the status bar, again from the View menu, click Status Bar. 

The status bar disappears as well. 
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Step 9: Change the interface again 

For this step, use what you've learned to return the interface to its appearance at the 

end of Step 3.  It should look like the View Result graphic below when you're finished. 
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Step 10: Identify a feature 

Identify button  

When you click the Identify button (by default, located on the Tools toolbar) and then 

click a feature on the map, the Identify Results window displays and shows the 

attributes for the feature. Identify is a quick way to find features with specific attributes. 

On the Tools toolbar, click the Identify button . 

Click the USA on the left side of the map.  

The Identify Results window opens. Examine the attribute values in the Identify Results 

window to find the area and perimeter's value. 

 

 
Step 11: Find a feature 

Find button  

If you want to locate a feature in the map display and you know what one of its 

attributes is, you can use the Find button. When you click the Find button, a dialog 

displays. You can specify an attribute and the layer or layers in which to search. You 

also have the choice of searching all the fields in a layer, specific fields in a layer, or 

each layer's primary display field (the default field used for feature labeling and map 

tips).  
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On the Tools toolbar, click the Find button . 

In the find box type Tunisia and In Layers select Countries94.  

When the search is complete, ArcMap displays all the layers and fields that matched the 

attribute you typed in. Right-clicking a search result displays a context menu where you 

have options to flash the feature in the display, zoom to the feature, select or unselect 

the feature, or create a bookmark. If you choose flash feature, you may not be able to 

see it if you're not zoomed in enough. Or, zoom to the feature and then use the zoom 

out tool until you can recognize the country’s location in the world. 

 

 

Step 12: Select a feature 

Arrange your windows so that you can see both the Find dialog and the map. Right-click 

the Tunisia name in the search result box and choose Select Features. Close the find 

menu box. In the main ArcMap frame, click on the extent zoom (add image) and then 

zoom into Northern Africa. 
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The feature is selected in the map display. 

 

 

Step 13: Change the selection color 

Now you'll change the selection color. 

In the Table of Contents, right-click Countries94 and choose Properties. In the Layer 
Properties dialog, click the Selection tab.  

Click Show selected features with this symbol. Click the symbol button to open the 
Symbol Selector.  
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In the Symbol Selector's Options area, click the Outline Color box. In the Color Picker, 
click a yellow square. 

The Preview area shows the new color you selected. 

Click OK to close the Symbol Selector. 

 

In the Layer Properties dialog, click OK to apply the new selection color. 

The building is now selected with a yellow outline. 

Step 14: Unselect Feature 

From the selection menu select Clear Selected Features. 
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Step 15: Set a bookmark 
 
Re-open the find dialog. 

In the Find dialog, right-click the Tunisia for the selected country and choose Set 

Bookmark.  

Close the Find dialog. 

From the View menu, choose Bookmarks, then click Tunisia. 

The map zooms to the extent of the country.  

To return to the original extent, click the Previous button  or the Full Extent button 

.  
You can also set, access, and manage bookmarks from the View menu. 
 
 
Step 16: Change the map scale 

The countries and cities are drawn at a scale that allows them to fit in the ArcMap map 

display area.  

Look at the scale box on the Standard toolbar to see the scale of the map. Depending 

on the size of your ArcMap window, your scale may be different than the one shown in 

the View Result graphic below. 

 

The scale box tells you that one unit on the map (e.g., one meter, foot, or mile), is equal 

to (in this example) 208,813,356 of the same units on the ground. 

Click the Zoom In button . Click and drag a box around Alaska. 
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Notice that the scale changed when you zoomed in (it became larger—a larger scale 

equates to a smaller denominator in the scale ratio) and that the amount of detail in the 

map increases with the scale. 

 

The coordinate location of your mouse pointer is displayed in the status bar at the 

bottom of the ArcMap window. Move your mouse pointer around the map (without 

clicking). Notice that the coordinates change. 

 
Step 17: Change the symbology for world countries 
 
In this step, you will change the color of the country polygons. 

In the Table of Contents, right-click the Countries94 polygon symbol (the square). 

 
The Color Picker displays. Experiment with changing the colors of the country polygons. 
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Step 18: Zoom in to South America 
 
Turn the cities layer back on by clicking the box next to the file name. 

Next, you'll zoom to South America to narrow the area of interest. 

On the Tools toolbar, click the Zoom In button . Draw a box around the South 

American continent. 

 

 

ArcMap zooms in to the contents of the box. 
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Step 19: Label map features 
 
In this step, you will label features on a map and add map tips. A map tip is a way to 

see attribute information about a feature.  

In the Table of Contents, right-click WorldCities (its name, not the symbol) and click 

Label Features. Labels appear for the cities. If some of the cities are not labeled, 

enlarge the display area. 
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Now you will add the map tips.  

Again, in the Table of Contents, right-click WorldCities and click Properties. In the Layer 

Properties dialog, click the Display tab, then check the box next to Show Map Tips.  

  

Click OK. Move your mouse pointer over a city on the map to see the associated map 
tip. 

The map tip appears in a box and should be the same as the city's label. 

  
 
 

Step 20: Start an analysis project 

For the remainder of this lab, you will work with data from Aquidneck Island, Rhode 

Island to perform geoprocessing tasks that are part of a fast food restaurant location 

analysis.  

As part of your analysis, you need to find busy roads in several strategic ZIP Codes. 

First, you will buffer the target ZIP Codes by 1.5 kilometers. You will then overlay the 
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buffer polygons with the island's street network to isolate those streets that fall within the 

buffers. In the second part of the analysis, you will identify the busy streets in the target 

areas. 

First, you will buffer the ZIP Codes that fall within Aquidneck Island, Rhode Island. 

Restore ArcCatalog. Arrange ArcCatalog and ArcMap so that both application windows 

are visible. 

In ArcCatalog, expand the Rhode_Island folder. 

  

In ArcMap, click the New Map File button . Click No when prompted to save your 

changes. 

From ArcCatalog, drag the island, streets, and zip feature classes into ArcMap. 

  

 Minimize ArcCatalog. 
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Step 21: Use the Buffer Wizard to create buffers 

Now you'll open the Buffer Wizard so you can buffer the target ZIP Codes. 

From the Tools menu, choose Buffer Wizard.  

In the first wizard panel, click the option to buffer the features of a layer and choose zip 

point as the layer.  

  
 
Click Next. In the next wizard panel, in the Distance units dropdown list at the bottom of 

the panel, choose Kilometers. Enter 1.5 for the buffer distance.  
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Click Next. Click Yes to dissolve barriers between buffers and click the option to save 

the buffers to a new layer. Click the Browse button and navigate to 

C:\RNG450\LAB_2\Section_a folder and save the layer as a shapefile named zipbuf. 

 
 
Click Save.  
 
 

 

 Click Finish to have the Buffer Wizard create the buffers. 

  

Lab 2 - 26 



Laboratory Manual for Landscape Ecology    Harris, Louhaichi & Johnson 

Step 22: Clip data with the Geo-processing Wizard 

When the Buffer Wizard is finished processing, the zipbuf layer is added to ArcMap. 

Arrange the order of the layers in the Table of Contents so that zip is at the top, streets 

is underneath zip, island is underneath streets, and zipbuf is at the bottom. 

  

Now you will use the ArcMap Geoprocessing Wizard to clip the island's streets to the 

buffer polygons you created around the ZIP Code points.  

From the Tools menu, choose GeoProcessing Wizard. Click Clip one layer based on 
another. 

  

 Click Next. 
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Next, you need to specify the clip parameters. 

For the input layer to clip, choose streets arc. For the polygon clip layer, choose zipbuf. 

Click the Browse button and save the output clip layer as a shapefile named 

Busy_Roads.shp in your Rhode_Island folder.  

  
 
 Click Save.  
 

 

Click Finish to clip the streets using the polgons from zipbuf. After a moment, the new 

layer is added to the Table of Contents. 
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Step 23: View the results in ArcMap 

All the busy roads within 1.5 kilometers of the ZIP Code points are displayed in ArcMap. 

In the Table of Contents, uncheck the streets arc layer. Now you see only the roads 

contained within the ZIP Code buffer polygons. 

  
  
 

Step 24: Measure distance  

When you want to measure linear distances between features on the map, you use the 

Measure button. As you start clicking at different point locations on the map, a thick line 

will appear.  

 

First, right click on the zip point layer and select label feature. You can see that the 

buffered areas around Portsmouth, Middletown, and Newport. 

 

With the Measure button, you can click on locations in the map's display area and get 

the distance between them. The distance is reported in the status bar at the lower left of 

the ArcMap application window. 
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You specify the display units reported in the status bar in the General tab of the Layer 

Properties dialog.  

As you move the mouse pointer from Newport towards Middletown, the status bar will 

report the length of the last segment as well as the total length of all the segments in the 

measurement transaction. To finish measuring, double-click at the end point. The gray 

connecting line will disappear, and the status bar will continue to show the last 

measurement. 

 
 

 
Step 25: Perform a spatial query 
 
You will create spatial and attribute selections and queries and create a selection layer. 
 
In this step, you will create a spatial query to select all the streets inside the Newport 

area. From the Selection menu, choose Select By Attribute. 

The Select By Attribute dialog opens. 

 

First clear all selections (click on selection  clear selected features) 

Display the streets arc layer. 
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In the Select By Location dialog, select streets layer that are within the city limit “CITYL”. 

Make sure your selections match the View Result graphic below. 

 

 

Click Apply, then click Close. 

After the query is applied, features in the Buildings layer are selected. 

 

This selection is now available for use in other operations. For example, you could 

create another dataset with it (i.e., a layer with fewer features), or you could calculate 

statistics for the selected buildings (like the total value of the flooded buildings). 

Spatial queries are important GIS tasks. They demonstrate the power of GIS to use 

spatial relationships to find answers that will help in decision making. 
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Step 26: Examine your selection in the attribute table 

 In this step, you will examine the attribute table for the streets layer. 

In the Table of Contents, right-click streets arc and choose Open Attribute Table. 

The Attributes of streets arc table displays. 

 

Notice that the total number of records (4595) and the number of selected records 

(1938) are shown at the bottom of the table window. When features are selected on the 

map, their corresponding records in the feature attribute table are also selected. Scroll 

down to examine the selected records. 

If you want, you can view only the selected records rather than all the records in the 

layer. 

Click the Selected button at the bottom of the table. 

Now you see only the records for the 1938 selected features. These are the streets 

inside the Newport area. 

 

Click the gray record box to the left of a record. The record is highlighted both in the 

table and in the map. 

Close the table. 
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Step 27: Close ArcMap and ArcCatalog 

Close both ArcMap and ArcCatalog. Click No when you're prompted to save changes to 

the map document. 

In this exercise, you used ArcMap and ArcCatalog to find data, display it on a map, and 

perform some common geoprocessing tasks. In the coming modules, you'll learn more 

about each application and have the opportunity to experiment on your own. 

Step 28: Exit ArcMap 

You should now feel more confident about changing ArcMap's interface. You've learned 

how to hide and display toolbars, the Table of Contents, the scroll bars, and the status 

bar. You've also learned how to open, close, float, and dock the Table of Contents in the 

ArcMap window.  

It should be clear that you can customize ArcMap's interface to match your preferences, 

whatever they are.  

Exit ArcMap. Click No when you're prompted to save your changes. 
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ArcToolbox   

ArcToolbox is the third standard application that comes with ArcView 8. As its name 

implies, ArcToolbox contains tools for working with your data. For ArcView 8, the tools 

in ArcToolbox are organized into two main toolsets: Conversion Tools and Data 

Management Tools. ArcToolbox also contains a third toolset called My Tools where you 

can store frequently used tools and custom tools. 

 

ArcToolbox contains both tools and wizards. A tool, indicated by a hammer icon in 

ArcToolbox, contains several input fields that you fill in with command options to 

complete the particular task. Tools have smart defaults—some fields are automatically 

filled in after others are filled in. Tools also allow you to run multiple jobs at once using a 

batch mode.  

Wizards are available to carry out more complex commands or sets of commands. 

Wizards, indicated in ArcToolbox with a magic wand icon, are like tools but instead of 

using one dialog for entering command options, wizards use multiple dialogs. The 

wizard dialogs walk you through the parameters you need to specify and include 
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instructions that help you fill in the options. Wizards are used for more complex tasks 

that require many parameters to be specified.  

ArcToolbox tasks are concentrated on shapefiles and geodatabases. For instance, you 

will find wizards for changing shapefile and geodatabase projections in the Projections 

toolbox of the Data Management Tools. In ArcView 8, ArcToolbox does not contain 

tools for geoprocessing tasks. The ArcMap Tools menu is where you access the 

Geoprocessing Wizard.    
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